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What's New
This document describes the enhancements that are delivered in Oracle
Communications MetaSolv Solution (MSS) 6.3 patches.

See the following for information on each patch:

• Enhancements in Patch 29940044 (6.3.0.1003)

• Enhancements in Patch 29746493 (6.3.0.982)

• Enhancements in Patch 29336894 (6.3.0.940)

• Enhancements in Patch 28962904 (6.3.0.904)

• Enhancements in Patch 28504540 (6.3.0.842)

• Enhancements in Patch 27753924 (6.3.0.772)

• Enhancements in Patch 27538212 (6.3.0.733)

• Enhancements in Patch 27474657 (6.3.0.679)

• Enhancements in Patch 27555375 (6.3.0.643.3)

• Enhancements in Patch 26557511 (6.3.0.639)

• Enhancements in Patch 26336562 (6.3.0.621)

• Enhancements in Patch 25541947 (6.3.0.555)

• Enhancements in Patch 25385094 (6.3.0.516)

Enhancements in Patch 29940044 (6.3.0.1003)
The following sections describe the enhancements delivered in this patch.

ASR 60 Support

MSS 6.3.0 patch 29940044 supports ASR 60.

Support for Oracle Fusion Middleware 12.2.1.4
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MSS now supports Oracle Fusion Middleware 12.2.1.4, and continues to support
Oracle Fusion Middleware 12.2.1.3.

New Reject Task Web Service

In addition to the existing CORBA API which allows you to reject a task, this release
provides a new Reject Task Web Service (rejectTaskRequest). See MSS Web
Services Developer's Guide for more information.

Enhanced ASR Process Supplement API

This release enhances the existing ProcessSupplement Web Service API to provide
the capability to process a supplement type 3 – Other for an ASR order.

Employee Network User ID Expanded from 20 to 50 Characters

You are now able to define the Network User ID of an employee using up to fifty
characters. This expansion will allow most email addresses to be captured and
associated with an employee record within MSS, which may then be leveraged by a
custom integration to a directory services database such as Active Directory.

End of Support for Windows 7

With Windows 7 due to reach end-of-life in January, 2020, MetaSolv Solution no
longer supports this operating system. Upgrade your client Windows environments to
the latest 8.1 or 10 release.

Enhancements in Patch 29746493 (6.3.0.982)
The following sections describe the enhancements delivered in this patch.

Auto-associate Network Element to Equipment when Populating
Net Loc (Equipment)

This feature enables the automatic association of a Network Element to a piece of
equipment whenever a new Net Loc (Equipment) is associated within the Equipment
maintenance window, and is controlled by the following system preference:

Equipment > Equipment Inventory > Auto-associate Network Element when
populating Net Loc (Equipment)

When only one network element is associated to the entered CLLI code, it will be auto-
populated within the Network Element field. In cases where more than one network
element is associated to the entered CLLI code, the application will automatically open
and trigger the retrieval of the associated elements within the Network Element
Search window. To auto-associate the desired network element, double-click or select
it from the list and click the OK button to close the window.
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When modifying the Net Loc (Equipment) for a piece of equipment already having an
associated network element, you will have the option to keep the existing value, or to
auto-associate a new element based on the newly-entered Net Loc (Equipment) CLLI
code.

Oracle Database 18c Certification

This release certifies MetaSolv Solution to run on Oracle Database 18c, and continues
to be certified on Oracle Database 12c.

Reopen Only Completed Tasks via Process Supplement API

When supplementing an order with either a New Due Date or Correction via the API, a
new system preference allows you to configure the application to only reopen
completed tasks, and will set their statuses to either Ready or Pending based on their
interdependencies.

To maintain task dependency, previously Ready tasks will also be set back to Pending
when any of their predecessors are re-opened. This capability allows you to retain task
dependencies for the order, and is controlled by the following system preference:

API > Re-open only completed tasks via Process Supplement API

Associate Multiple Rate Codes to a Port Address

You can now associate multiple rate codes to an equipment spec port address, as well
as define a unique child hierarchy for each associated rate code. For example, you
may define a physical port with a DS3 rate code having a child DS1 > DS0 structure,
and also associate an STS-1 rate code having a VT1 > DS1 child structure to the
same physical port. Equipment instances having multiple rate code definitions for a
port may only utilize one of the associated rate codes at any given time.

To enable this capability, two new options are now available in the right-click menu
within the Port Addresses tab of the Equipment Spec window. To associate an
additional rate code to a top-level physical port, select the desired port's row and
select Add Additional Rate Code from the right-click menu to insert a new row
representing the same port. Once inserted, you can select the desired rate code within
the Rate Code drop-down. You may add more than one additional rate code to a port,
if desired.

To define a child port hierarchy for the new rate code, you need to select the desired
row and click the Next button. All rows representing an additional rate code for a port
are identified by red text within the Rate Code column, and also provide the row of the
base port which they extend between parentheses within the Line column.

To remove an additional rate code definition from a port address, select the desired
row within the Port Addresses tab of the Equipment Spec window, and select
Remove Additional Rate Code from the right-click menu. This action will remove the
physical port and its entire child hierarchy from the specification.

Once defined for the equipment specification, you may choose which associated rate
code to use for each port within each instance of the specification. This is done within
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the Port Addresses tab of the Equipment maintenance window, which now allows
you to select the desired rate code from the associated list within the Rate Code drop-
down. In addition to updating the rate code of the particular port, selecting a different
rate code also updates its entire child hierarchy based on the equipment specification
port address definition.

When making a port assignment, the existing rate code validation logic still prevents
you from assigning a circuit to a port when the rate codes are incompatible, but now
notifies you when the port's rate code may be changed to support the circuit
assignment.

Quickly Manage Condition Codes for an Equipment Hierarchy

The Condition Code Range Assignment window now provides you the capability to
quickly and easily manage condition codes for an entire equipment hierarchy. While
the window continues to function the same as before, a new Equipment drop-down
field, which is populated with the entire child hierarchy of the equipment the window
was initiated from, allows you to easily transition between each piece of equipment
within the hierarchy.

When you are done managing the condition codes for the currently selected
equipment, you may select your next piece of equipment within the Equipment drop-
down. To manage the condition codes for the newly-selected equipment, you must
confirm the notification stating that all prior changes will be saved, which will then
reload the window with the ports and slots of the selected equipment.

To allow you to easily identify the equipment within the Equipment drop-down, it
describes each piece of equipment based on the same user preference which builds
the equipment description within Equipment Inventory. Each value is also preceded
with the slot number, which allows you to distinguish between common sibling
equipment.

Remove Port Address Locks

This feature expands upon the existing capability which allows you to remove
database locks on locked objects from within the application. In addition to having the
existing capability to remove locks for connections, network systems, network
templates, and network grooming projects, the Remove Locks window now allows
you to remove locks for port addresses.

The Remove Locks window continues to support standard MSS security features, as
well as the existing system preference restricting you from viewing and removing other
user's locked objects.

Enhancements in Patch 29336894 (6.3.0.940)
The following sections describe the enhancements delivered in this patch.

ASR 59 Support

MSS 6.3.0 patch 29336894 supports ASR 59.
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Configure an Equipment Specification to Display its Slots before
its Ports

Previously, the Equipment Inventory hierarchical view always displayed a piece of
equipment's port addresses first, followed by its defined slots.

With this enhancement, you are now able to configure an Equipment Specification to
display its slots prior to its port addresses within its hierarchical view.

A new check box Display Slots Before Ports within the Mounting Positions tab of
the Equipment Spec maintenance window allows you to configure this. Select the
check box on a new or existing specification having installed instances to modify the
display. For continuity, the same check box is visible within the Mounting Positions
tab of the Equipment maintenance window, but it is read-only as the setting is
controlled by the specification.

In addition to the main hierarchical view within Equipment Inventory, this new setting is
also reflected within the hierarchical equipment views throughout the application. Two
examples are the Equipment Spec View, which may be opened from either the
Equipment Spec or Equipment maintenance windows, and the Network Element
Equipment window opened from the Network Element Properties window.

Ability to Remove a Connection from an Access Service Request
(ASR)

Expanding upon the previously-released capability to remove a connection from an
Engineering Work Order (EWO), an Internal Service Request (ISR), and a Product
Service Request (PSR), you are now also able to remove a connection from Access
Service Request (ASR).

For connections on an ASR having a change activity, similar validation now exists
which identifies the type(s) of assignment(s) which must be reverted to their previous
state before the connection can be removed from the order.

Similar to other order types, once a connection is removed from an ASR, the
associated pending design issue is deactivated and marked as Overridden, as well as
populated with a design note identifying the order for historical tracking. Additionally,
the Activity of the connection with the order is updated to Removed within the design
issue lists of Connection Design and Connection Design Search.

New Validation Message When Changing the Location of a
Shared Element/Component

When changing the location of a component that is shared in one or more networks,
you are now presented with a validation message notifying you that the change will be
reflected by every instance of the component. The new message is triggered
whenever you modify the Network Location within the Managing a Component/
Element window opened within Network Systems, and provides you the option to
keep or discard the modification. If you choose to discard the change, the Network
Location will revert to its original value.
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Ability to Add Partial Protection for Intra-networking Segments for
an Optical Network Assignment

While you have been able to add a partial-protect path to an optical network working
path, MSS previously only allowed you to protect inter-networking connections
between networks.

With this enhancement, you are now able to partially protect intra-networking
segments between components within the same network system, in addition to the
already protectable inter-networking segments.

To access this new capability, open the Provisioning Assistant: Build Partial
Protect Path window by right-clicking on an un-protected Network block within
Connection Design and selecting Build Partial Protect Path… from the popup menu.
The window will load the same data as before, but you now have the option to append
the partially-protectable intra-networking segments to the current list, which you do by
clicking the new Load All Paths button located under the Next button. The list is built
from the potential connections between the components of the working path that have
additional connectivity that is not part of the working path.

A new “--- INTRANETWORK PATHS ---" delimiter separates the intra-network
segments from the existing inter-networking segments so that you may easily identify
them. Because some of the segments may overlap one another, the Complete
Protection check box is now disabled upon clicking the Load All Paths button as it is
no longer applicable. You may now select the paths to protect, and finish the process
the same as you always have.

Ability to Reference In-Progress Bandwidth within the Access
Connectivity ID for a Multipoint Ethernet Site Product

This feature extends the supported use cases within the MSS/UIM reference
integration for multipoint service orchestration. The previous restriction which allowed
you to only designate an In Service bandwidth connection within the Access
Connectivity ID label for a Multipoint Ethernet Site service item has been relaxed,
which enables you to now order the bandwidth connection on the same Product
Service Request as the multipoint service, or a separate in-flight PSR.

As the CPE Component Name may not be known until the access bandwidth is
designed, it is now no longer required to be populated on the order.

Because the access connectivity is no longer required to be In Service to be
referenced on the order, the reference integration now provides additional logic to
retrieve the port and CPE component information from the design of the referenced
bandwidth connection. Because these attributes are required by UIM to design the
service, MSS will stop the process and trigger an error when either of these attributes
cannot be retrieved.

Additionally, new validation logic when attempting to due date complete the multipoint
order ensures that all bandwidth connections referenced within the Access
Connectivity IDs of all the Multipoint Ethernet Sites are either already In Service, or will
be placed In Service as a result of completing the order. When one or more
connections block the completion of the order, you are now presented with a list of the
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blocking connection(s) and their blocking order(s) when completing the due date task
manually, and an error message is logged when the task is processed via the
background processor.

Enhancements in Patch 28962904 (6.3.0.904)
The following sections describe the enhancements delivered in this patch.

Display Circuit Priority Codes within Connection Design Search

This feature expands the visibility of Circuit Priority Codes to Connection Design
Search results. Whenever a circuit having a defined priority code is retrieved, its
priority level can be easily identified by its corresponding graphic within the first
column of the result set. These graphics are easily recognizable as they are the same
ones previously available within Connection Hierarchy to identify priority circuits. The
new column will only be visible when one or more circuits within the result set have an
associated priority code.

Open Service Request User Data Directly from Service Request
Search Results

This enhancement enables you to quickly view and maintain an order's user data
directly from Service Request Search, without opening the order. A new Service
Request User Data… menu option is now available for Access Service Request
(ASR), Engineering Work Order (EWO), Internal Service Request (ISR), and Product
Service Requests (PSR).

When selecting this new option, the appropriate user data window is displayed
depending upon the type of order you have selected.

Ability to Remove a Connection from an Internal Service Request
(ISR) and a Product Service Request (PSR)

This feature expands upon the previously-released capability to remove a connection
from an Engineering Work Order (EWO). Now, you are also able to remove a
connection from both an Internal Service Request (ISR) and a Product Service
Request (PSR). Previously, while you were able to remove a connection from a PSR
having a new activity, this action was not available for change or disconnect activities,
which are both now supported.

Additionally, the process of removing a new activity connection from a PSR which has
pending assignments tied to the order, either by selecting Delete Circuit or Delete
this Item, now provides you with informational messages stating the assignment
type(s) which must be removed prior to removing the connection.

For connections having a change activity on either an ISR or PSR, similar validation
exists which identifies the type(s) of assignment(s) which must be reverted to their
previous state prior to removal from the order.
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After passing validation, the successful removal of a connection from an ISR or PSR is
accompanied by a design note within the issue associated to the order, identifying the
order from which the connection was removed.

Similar to an EWO, once a connection is removed from an ISR or PSR, the associated
pending design issue is deactivated and marked as Overridden. Additionally, the
Activity of the connection with the order is updated to Removed within the design issue
lists of Connection Design and Connection Design Search.

Automatic Assignment to Child Work Queues Added to Rules and
Behaviors

Rules and Behaviors now consider the type of Assignment when assigning out
tasks. When executing Rules and Behaviors that result in tasks being added to a
parent Work Queue that is configured for Automatic Assignment, the tasks are now
automatically assigned to a child work queue, which was not previously supported.

Equipment Model Number Expanded to 35 Characters

The Equipment Specification Model Number
(ASAP.EQUIPMENT_SPEC.VENDOR_MODEL_NUMBER) now supports up to thirty-
five characters, which expands upon the previous column definition of fifteen
characters. To accommodate this change, the Model Number field within the
Equipment Spec window has been widened to display as many characters as the
window will allow.

Note:

The Equipment CORBA API will only retrieve the first fifteen characters of
the model number until the IDL is updated to accommodate the length
change; IDL changes are not candidates for delivery within a patch, and
must be delivered within a service pack upgrade.

Cascaded Installation of Under Construction Equipment within
Equipment Inventory

Improving the usability within the Equipment Inventory hierarchy, you are now able to
cascade the installation of equipment down an equipment hierarchy. When modifying
the Status of a piece of equipment, which has children associated to the same
Equipment Work Order, within the Equipment maintenance window from Under
Construction to Installed, you now have the following options:

1. Install only the parent equipment.

2. Install the parent equipment and all child equipment associated to the same
Equipment Work Order.

8



This enhanced behavior decreases the time necessary to install the equipment, and
provides an easy mechanism to install child equipment.

Note:

This capability is only available for equipment managed via an Equipment
Work Order. The installation of all equipment tied to a service order, such as
an Engineering Work Order or Product Service Request, must be installed
from the context of the associated service order.

Capability to Provide a Description for Soft Connections within
Virtual Schematic Design

While soft connections within a virtual connection's schematic design do not represent
an allocation to a specific parent connection, and therefore cannot be configured with
an allocation parameter custom attribute, there are times when these relationships
warrant a description. To meet this need, you are now able to enter a description for all
soft connections, up to 150 characters.

When right-clicking on a soft connection, a new Specify Virtual Description menu
option replaces the previous Specify Virtual Channel option which does not support
soft connections. Selecting this option opens the new Specify Virtual Description
window where you may enter the desired alphanumeric description. After closing the
window, the entered description displays as a label attached to the associated soft
connection.

New Capability to Easily Create Multiple Copies of Equipment

Expanding upon the existing methods to copy equipment within Equipment
Inventory, you are now able to easily copy and install multiple instances of the same
equipment specification into a contiguous range of mounting positions.

To initiate the process, right-click on the source equipment and select Copy, then
right-click on the target mounting position and select the new Copy Range To menu
option. This action triggers the application to begin creating and installing new
instances of the source equipment into the contiguous mounting positions between the
source equipment and target mounting position, regardless of direction.

When installing the new equipment within the designated range, positions which are
currently occupied by other equipment, or have a blocking condition code, will be
skipped. When one or more Informational condition codes exist within the designated
range, you are given the option whether or not to skip over the conditioned slots.
When copying equipment that occupies multiple slots, the process creates and installs
as many instances of the source equipment that fit within the designated range, which
may result in some unoccupied slots.

Because this new copy functionality is performed within a range, the new Copy Range
To menu option is only enabled when the target slot belongs to the same parent
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equipment wherein the source equipment is mounted, and is within the same sibling
hierarchy; otherwise, this option is not available.

Enhancements in Patch 28504540 (6.3.0.842)
The following sections describe the enhancements delivered in this patch.

ASR 58 Support

MSS 6.3.0 patch 28504540 supports ASR 58.

Existing MSS/UIM Reference Integration for VLAN Management
Expanded to Support MSS Network Grooming

The reference integration for VLAN Management between Oracle Communications
Unified Inventory Management (UIM) and Oracle Communications MetaSolv Solution
(MSS) now supports the assignment and management of VLANs within the context of
an MSS Network Grooming project.

To support this capability, a new Generate Virtual Channels menu option is now
available within the MSS Network Grooming project, which does the following:

• Packages up the current and pending design changes for every highlighted
connection to send to UIM, which will determine, track, and send back the
appropriate VLANs, to be stored within MSS

• Creates or updates an existing Business Interaction within UIM to manage the
VLANS, which is tied directly to the MSS Network Grooming project

• Tracks all of the connections on the Network Grooming project within this single
UIM Business Interaction, thus simplifying the use and maintainability of the
VLANs

• Automatically creates and stores a direct link to the UIM Business Interaction
within the Network Grooming project for easy navigation and maintenance

Additionally, the reference integration now supports the following activities, which
enable it to keep the VLAN data synchronized between MSS and UIM:

• Validate Groom: Responsible for validating all VLAN data is synchronized
between MSS and UIM prior to generating the Network Grooming order within
MSS

• Remove Connection from Groom: Responsible for updating the statuses of any
VLANs associated to a connection that is removed from a Network Grooming
project

• Delete Groom: Responsible for deleting the UIM Business Interaction associated
to the Network Grooming project, and updating the associated VLANs

For detailed instructions about installing the required software, setting up UIM and
MSS, and integrating UIM with MSS for the reference implementation, see Knowledge
Article 2472722.1 - Integrating MetaSolv Solution with Unified Inventory Management
for VLAN Management on the My Oracle Support website:
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Enhanced Selection and Filtration of Work Queues

This feature enables you to find a desired work queue more quickly and efficiently
within the application, specifically within the Work Queue Manager and the Task
Transfer windows.

Within Work Queue Manager, this feature allows you to quickly find the specific work
queue you are looking for, and to quickly load the tasks within that queue, without first
loading all of the tasks of an undesired work queue. This streamlined behavior enables
you to load and navigate between work queues more efficiently, thus improving your
overall productivity.

This capability is facilitated by a new behavior within the Work Queue drop-down list,
which enables you to enter your desired work queue, but not retrieve any tasks until
you trigger the retrieval by selecting the desired queue. Previously, the tasks of any
matching work queues were automatically loaded into the window while you typed
each letter, even though you had not finished typing your selection, which led to the
retrieval of unwanted data.

Additionally, the Work Queue field now also treats the text you type as filter criteria,
which dynamically filters the list of available work queues based upon this criteria,
whenever the drop-down list is populated. By default, it behaves like a begins with
filter, but you have the option to change this behavior to a contains or ends with filter
by typing the % wildcard character anywhere within the field. You can easily reset the
filter to display all associated work queues by removing some or all of the entered text.

As you type, you have the option to select from the list of matching work queues,
which will trigger the retrieval of the tasks for that queue. After an exact match is
found, that work queue is automatically highlighted, and you can retrieve its tasks by
pressing the Tab or Enter key, or by clicking the work queue with your mouse.

Now that the Work Queue field enables you to type any text, new validation messages
notify you of any work queues that do not exist, which you may have entered
incorrectly, as well as notify you of any valid work queues that exist, but do not belong
within your Personal work queues or Work Group, depending upon which option you
have selected.

This feature also enhances the overall usability of the Task Transfer window by adding
a new set of filter criteria within an improved layout. Two new fields allow you to filter
the list of displayed work queues, one by typing in the owner, and the other by typing
in the work queue, which filters on both the Work Queue and Parent Work Queue
columns.

Similar to the enhanced Work Queue drop-down list within Work Queue Manager,
these two new fields dynamically filter the list of queues as you type each letter within
each of the fields. Each field behaves as a begins with filter by default, but also
supports the % wildcard character, which enables you to perform a contains or ends
with type of filtration. You can generate a more unique filter by providing filtration text
within both fields simultaneously.

Search by ICSC within Connection Design Search
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This enhancement allows you to search for circuits ordered via Access Service
Requests (ASR) using Interexchange Customer Service Center (ICSC) codes within
the Connection Design Search window. To enable this capability, the existing Service
Request secondary criteria now includes a new ICSC drop-down list. You can access
the ICSC drop-down list by right-clicking in the Connection Design Search window and
selecting Service Request.

Similar to the ICSC drop-down list found within an Access Service Request Search,
this new field is represented as a preloaded drop-down list, which allows you to select
the desired criteria. The value that you select from the new ICSC drop-down list is
appended to the other search criteria, and limits the results to only return matching
circuits that are associated to an ASR order having the requested ICSC.

Search for Access Service Requests (ASR) by ICSC within
Service Request Search

This enhancement allows you to search for Access Service Requests by
Interexchange Customer Service Center (ICSC) within Service Request Search. To
enable this capability, a new pre-populated ICSC drop-down list is now available with
the existing criteria when you choose ASR and Service Request within the Search By
group box.

The value that you select in the ICSC drop-down list is included in the search criteria,
which limits the search to return only the ASR orders having the requested ICSC in the
Administrative section or listed within the Multi-EC form.

Require Task Reject Reason Code

When rejecting a task using the Task Reject window, you are now required to populate
the Task Reject Reason drop-down list whenever the Enable Task Reject Reason
Codes preference is enabled under Preferences - Work Management - Work Queue
Management. While this preference still controls whether or not the drop-down list is
enabled within the window, the field is now always required whenever it is editable.

Previously, with the Enable Task Reject Reason Codes preference enabled, you had
the option of either populating the Task Reject Reason drop-down list or providing a
reason in the Service Request Note - Reject Reason field to close the window. While
this new behavior still enables you to enter a reject reason in the Service Request
Note - Reject Reason field, you must always do this in conjunction with selecting a
task reject reason within the Task Reject Reason drop-down list.

You must continue to provide a reason in the Service Request Note - Reject Reason
field when the Enable Task Reject Reason Codes preference is disabled, because it
is the only field in which you can provide a reason.

Display Address Information for CLLI Locations within Connection
Design

Previously, for design issues associated to either an Access Service Request (ASR) or
Internal Service Request (ISR) within Connection Design, the Locations tab of the
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Additional Details page displayed the address information for the primary and
secondary locations when they were defined as end user locations, but not when
these locations were identified with CLLI locations.

The address information is now displayed for both the primary and secondary
locations for special and facility circuits, as well as bandwidth connections, regardless
of whether either location is defined as a CLLI or an end user location.

Ability to Remove a Connection from an Engineering Work Order

Previously, after you created a design issue for a connection by opening it from an
Engineering Work Order (EWO), you were no longer able to remove that connection
from the order, regardless of whether or not you had performed any design or
assignment changes.

This behavior had the potential to require a substantial amount of rework if you chose
the incorrect connection to bring onto the order, or if it was no longer required for the
order. Without the ability to remove the connection from the order, you were required
to cancel the existing order and submit a new one.

Although you still cannot remove connections from an EWO having associated
assignments, you can now remove connections from an EWO after you have reverted
the assignment changes. This capability enables you to complete the order more
quickly, because you are no longer required to cancel and resubmit the order.

To enable this capability, the existing validation logic (which previously prevented you
from removing any connection having a design issue associated to the order) now
determines whether or not any pending assignment changes are linked to the order;
when none exist, you can remove the connection from the EWO.

When you try to remove one or more connections from an EWO that has one or more
pending assignments for that order, the application displays a list of the assignment
types that are blocking the removal for each connection. Additionally, when you try to
remove a connection that has a new activity for the order, the application validates that
no child circuits are assigned to that connection, and notifies you accordingly.

The following list describes the various assignment types:

• Allocation: Indicates that the connection has one or more pending bandwidth
assignments

• Cable Pair: Indicates that the connection has one or more pending fiber/pair
assignments

• Channel: Indicates that the connection has one or more pending channel
assignments, which may belong to a facility, or Optical or SONET/SDH network

• Child circuits: Indicates that the connection has one or more child circuits
assigned to it

• Equipment: Indicates that the connection has one or more pending port
assignments

After passing validation, the successful removal of a connection from an EWO is
accompanied by a design note within the issue associated to the order, which states
the Work Order Number that the connection was removed from.
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After a connection is removed from an EWO, the pending design issue representing
that order is deactivated and marked as Overridden, and all other active design issues
for that connection are bumped up, if necessary. Additionally, the Activity of the
connection with that order is updated to Removed within the design issue lists of both
the Connection Design and Connection Design Search windows.

To differentiate between design issues for connections that have been removed from
an order and those that were created as part of the DLR reconciliation process (neither
of which are directly associated to the displayed order), all design issues created via
the DLR reconcile process are now identified by the Activity of Reconciled within the
design issue lists of both the Connection Design and Connection Design Search
windows.

To remove a connection from an EWO:

1. On the navigation bar, click Inventory Management, and then click Engineering
Work Orders.

The Engineering Work Order Search window is displayed.

2. Enter your search criteria and click Search.

3. Click the appropriate Work Order Number link from the search results.

The EWO is opened in the Engineering Work Order - Summary window.

4. Under Related Pages, click the Manage Connections link.

The Manage Connections window is displayed.

5. Select the check box beside the connection that you want to remove from the
order and click Remove.

Optical/TDM and SONET/SDH Network Hierarchical Views Now
Display the Non-channelized Child Hierarchies of Provisioned
Bandwidth Connections

Although the Optical/TDM and SONET/SDH network systems have always displayed
the bandwidth connections assigned within the channelized hierarchies of these
networks, the non-channelized child hierarchies of these provisioned bandwidth
connections were not previously visible within these network systems.

With this enhancement, the child hierarchies of all bandwidth connections provisioned
to a channelized network system are now displayed within the hierarchical views of
both the Optical/TDM and SONET/SDH network systems.

To view the non-channelized child hierarchies of a bandwidth connection provisioned
to either an Optical/TDM or a SONET/SDH network system, select Network Systems
within the Inventory Management navigation panel, and open the desired network
system.

After you open the network system, select the Hierarchical View right-click option and
navigate to the parent facility (containing the provisioned bandwidth) for which you can
now continue to drill down the non-channelized hierarchy of the bandwidth connection.
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Additionally, for Optical/TDM network systems, you can now view the non-channelized
child hierarchies of provisioned bandwidth connections within the Managing a
Connection window.

This enhancement also extends the capability of all network systems built from a
template within the UNCLASS categorization by enabling you to view the child
hierarchies (channelized or non-channelized) of all connections associated to the
network.

Enhancements in Patch 27753924 (6.3.0.772)
The following sections describe the enhancements delivered in this patch.

Integration with Oracle Communications Unified Inventory
Management to Support VLAN Life-Cycle Management

This enhancement includes a reference implementation that enables you to integrate
Oracle Communications MetaSolv Solution (MSS) with Oracle Communications
Unified Inventory Management (UIM) to enhance the existing capabilities of MSS to
support VLAN life-cycle management.

This integration of MSS' functionality for VLAN assignment with UIM's robust service
orchestration and resource management capabilities offers a highly adaptable and
scalable enterprise solution for ordering and designing services requiring VLANs, in a
fully-orchestrated, flow-through environment.

This reference implementation offers the following advantages:

• Reduces delivery time by automating the VLAN selection

• Improves service quality and reduces problem resolution time by tracking the
VLAN life cycle

• Increases the accuracy of the connection design

• Provides a short delivery cycle without requiring any conversions

• Maps the VLANs to the network component, port, or domain setup on the network

• Integrates directly into MSS workflows, thus requiring limited additional training

• Provides an automation framework for MSS

• Provides a Federation Framework for integration to other systems

The reference implementation uses a cooperative inventory design approach that
shares UIM data with MSS data, and displays the data within the MSS application. The
physical connectivity, virtual connectivity, equipment, port assignments, and networks
continue to reside within the MSS inventory. UIM manages the additional entities for
service, VLAN IDs, and VLAN domains, thus allowing you to extend MSS connection
design to include additional capabilities.

The Virtual Connection Design process integrates the cooperative inventory design
approach using the Generate Virtual Channels option, which is available on the
Options menu within the schematic design of a virtual connection.
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Using the Manage Allocation Parameters action type, which is available within the
custom extension process point for Connection Design, you can automate the
integration between MSS and UIM. The extension point sends the design information
to UIM using the UIM Service Order Fulfillment Web Service (SFWS). Additionally, the
reference implementation provides the UimVLANRequestAdapter, which retrieves
the MSS data, formats the request, processes the response, and provides a flexible
and customizable design solution to meet your specific business requirements.

For detailed instructions about installing the required software, setting up MSS and
UIM, and integrating MSS with UIM for the reference implementation, see Knowledge
Article 2472722.1 - Integrating MetaSolv Solution with Unified Inventory Management
for VLAN Management on the My Oracle Support website:

https://support.oracle.com

New READ-ONLY Security Group

A new READ-ONLY security group is now delivered as base data, which limits all
associated users to read-only user access throughout the application. Additionally, a
new system preference labeled Default Security Group is now available, which
allows you to specify the security group with which all the new users are associated
when the users are created within the application. The Default Security Group
preference is located under Preferences - Security.

You can combine these two features to effectively limit all newly created users within
the application to have read-only access throughout the application, by default. You
are no longer required to associate new users to your own security group, in which you
have defined your own read-only access, to limit their access to the application.

The new preference defaults to the DEFAULT security group, which mimics the
product functionality prior to this enhancement. However, you can modify the value by
selecting the new READ-ONLY security group from the list within the preference,
which automatically associates new users with this group, thus limiting them to have
read-only access throughout the application.

Setting the New Preference

To set the new preference:

1. On the navigation bar, select Home, and then My Preferences.

2. Within the Preferences window, double-click the Security folder to expand it.

3. Double-click Default Security Group.

The Default Security Group System Preference window is displayed, which has a
list that contains all of the security groups defined within the application.

4. From the list, select a value to define the default group which all new users will be
associated. For example, select the newly available READ-ONLY security group to
create all the new users with system-wide, read-only access.

Display Label/Value Pairs within Virtual Connection Design
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This enhancement expands the availability of information within Virtual Connection
Design by displaying the Label/Value pairs, which have been defined for the product
within the Product Service Request.

To display these values, a new Product Catalog tab is now available next to the
existing ISI-DLR tab within the Additional Detail page of Connection Design for a
virtual connection. Similar to how this information is displayed within Connection
Design for a physical connection, each label/value pair has its Data Label, Value, and
Activity displayed.

Each label/value pair is displayed on its own row within the page, and is read-only. If
desired, you can modify the values from within the service request.

Easily Transfer SONET Node Ownership

While SONET nodes can be shared into multiple SONET networks, each node can
only be updated from within its owning network, and is therefore read-only within all of
the other networks in which it is shared. As a result, a SONET node shared into other
networks cannot be removed from the owning network.

To remove the node from the owning network, its ownership must be transferred to
one of the networks in which it is currently shared. This new feature facilitates this
process via a new Transfer Ownership right-click menu option within the Network
Assoc. page of the Node Properties window. This option is available for every instance
of the node, and can therefore be performed from within any SONET network
containing the node.

To transfer ownership of the node, open the Node Properties window for any instance
of the node from within its SONET network, and navigate to the Network Assoc. page,
which displays all of the networks which contain the node. The Associated Networks
column identifies the name of the SONET network, while the ownership status is
displayed within the Type column. To transfer ownership to a different network, right-
click within the row representing your desired network, and select the Transfer
Ownership right-click menu option.

The network list will be updated to reflect the change, as will the capability to update or
remove the node from the network.

Note:

To transfer ownership of a SONET node, ensure that only one network
containing the node is open and all the other networks containing the node
are closed. If you receive an error, close all the other networks containing the
node and try again.

Easily Mark and Identify Important Circuits

This new feature allows you to define your own circuit priority codes, associate them to
all circuit types, and easily identify circuits having a priority code within Connection
Hierarchy.
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Defining Circuit Priority Codes

You can create new circuit priority codes and manage existing ones from the new
Circuit Priority Codes window. You can open this window from any of the following
locations:

• From Application Setup:

1. From the navigation bar, click Application Setup, and then click Inventory
Management Setup.

2. Under Connection Design, click Circuit Priority Codes.

• From Find Links:

1. At the top of the navigation bar, click Find Links.

The Find Links page is displayed.

2. In the Link field, enter circuit priority codes.

You can create a new code by selecting New… from the File menu or by selecting the
Add New link. You can also create a new code based upon an existing code by
selecting New From…. from the File menu. All three options will open the new Circuit
Priority Code window, where you define the code by entering the Priority Code and
specifying its Priority Level, which you will select from the pre-defined list. You can
also optionally provide a description for the code. You can define as many codes as
necessary; however, a circuit can have only one priority code associated at any given
time.

Associating a Circuit Priority Code to a Circuit

After you have defined the codes, you may associate them to a circuit from within the
Connection Design window by populating the new Priority drop-down list, which is
located at the bottom of the General tab within the Properties page.

You can open the Connection Design window by clicking Inventory Management on
the navigation bar, and then clicking Connection Design.

While each type of circuit has slightly different attributes within this tab, the new
Priority drop-down list is generally located in the same location for all circuit types.

Identifying Circuits Having Circuit Priority Codes

Within Connection Hierarchy, circuits having an associated priority code are easily
identified by new graphics, which not only alert you of their association without the
need to open Connection Design, but also indicate the priority level as one, two, or
three. Additionally, parent circuits containing an assigned child circuit having a priority
code (anywhere within its hierarchy) are also easily identified by a new graphic, which
immediately notifies you of its existence without requiring you to expand the full
hierarchy to find the prioritized circuits.

You can open the Connection Hierarchy window by clicking Inventory Management
on the navigation bar, and then clicking Connection Hierarchy.

The following types of hierarchies support this capability:
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• Channelized circuits

• Optical network hierarchies

• Non-channelized bandwidth connections

• SONET/SDH routes

• User-defined network routes

• Protected network routes

Enhancements in Patch 27538212 (6.3.0.733)
The following sections describe the enhancements delivered in this patch.

ASR 57 Support

MSS 6.3.0 patch 27538212 supports ASR 57.

Component Addresses Displayed within Virtual Connection
Design

This enhancement improves the usability within Virtual Connection Design by
displaying the address next to the Location Name and Network Name columns within
both the Network System/Element Search and Select Terminating Element windows,
respectively.

Displaying the address information enables you to more easily select the proper
component when using an end user location for a network component, because the
name of the location may not always be unique.

You can view the newly added Address columns when designing a new virtual
connection or when redesigning an existing virtual connection.

Click the Originating Network link to open the Network System/Element Search
window. A new Address column is now available (after the existing Location Name
column), which displays the concatenated address information for each returned
element.

After you have chosen the terminating network, select the Terminating Element link
to open the Select Terminating Element window, which now also displays a new
Address column (after the existing Network Name column).

In addition, the Network System/Element Search window has also been enhanced to
display the results in a more visually appealing manner, which improves its usability.

Capability to Copy Read-Only User Data

This enhancement provides the capability to copy the data from read-only user data
fields, which you can paste into another window within MSS, an email, or another
application.
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This enhancement improves the usability of the application and enhances your
productivity by enabling you to copy data easily and more efficiently.

After you have highlighted the data within the read-only user data field, copy the data
by using Ctrl+C, or from the Edit menu, select Copy, which copies the data to the
clipboard.

This enhancement supports copying data from numeric, character, and date fields, but
does not support copying data from user data fields defined as dropdowns.

Searching for Service Requests by User Data

This enhancement adds the capability to search for service requests by the user data
defined for each type of request.

To search for service requests by user data, a new User Data option is now available
within the secondary list beside the Search By list in the Service Request Search
window.

The User Data option is available only when you select ASR, EWO, ISR, or PSR from
the Search By list, because these are the only service request types for which you
can define user data.

When you select the new User Data option, the search criteria is updated to display all
of the defined user data for the type of order you have selected.

Searching for Circuits by Telecom Service Priority

This enhancement enables you to search for circuits by Telecom Service Priority
(TSP) within the Connection Design Search and Connection Hierarchy Search
windows.

To enable this capability, a new Telecom Service Priority (TSP) right-click option is
now available within the Connection Design Search and Connection Hierarchy Search
windows.

Selecting the new right-click option displays the following newly added options below
the existing criteria within both the Connection Design Search and Connection
Hierarchy Search windows:

• Telecom Service Priority field: Enables you to search for circuits by specifying
the TSP code for the circuits.

• Include 'Previous' Design Issues check box: Enables you to search through
historical, non-active design issues.

Because each connection design issue can have its own TSP value, searching for
circuits by TSP code retrieves all connections with a matching TSP within any of its
active design issues, which are in either Current or Pending status. To expand the
search to also include all previous design issues, select the Include 'Previous'
Design Issues check box.

In the Search Results window, you may open a connection that does not have a
matching TSP, which means that this connection was retrieved because another
design issue for that connection does have a matching TSP. Overridden design issues
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are not retrieved in the search, because those issues were overridden prior to going
into InService status.

UIM-specific Links Now Opened within MSS

Prior to this enhancement, some of the URLs specific to Oracle Communications
Unified Inventory Management (UIM) opened within the MSS application, while other
UIM-specific URLs opened within an external web browser.

With this enhancement, all the UIM-specific URLs now open within the MSS
application.

The UIM-specific URLs are opened within the UIM application whose URL you
specified in the UIM URL preference under Preferences - Unified Inventory
Management, as follows:

http://hostname:port/Inventory

where hostname is the application server used by UIM and port is the port used by
UIM.

You can access the UIM-specific URLs by:

• Clicking the Links tab in the Product Service Request window

• Selecting the Add Link right-click option in the Work Queue Manager window

• Clicking Maintain Order Links under Actions in the Connection Design window -
Connection Summary View for ordered connections

Ability to View Task Gateway Event Details from the Service
Request Search Results Window

This enhancement provides direct access to gateway event notes and error
information from the Service Request Search results window.

Previously, when orders were held up due to a gateway event error, you were required
to have access to the work queue containing the task to view and understand what
was preventing the task from completing.

With this enhancement, you can now access the gateway event error information and
populate gateway event notes directly from the Service Request Search results
window. Therefore, you are no longer required to figure out which work queue the task
belongs to. This capability enables you to resolve the issues more quickly, thus
improving your service delivery performance.

You can access this new capability from the Tasks tab of the Service Request Search
results window. Right-click a task and a new context menu displays up to five gateway
events associated to that task, if applicable. The context menu displays the name of
each gateway event, followed by its status in parentheses.

For each gateway event listed, there is a secondary right-click menu that contains the
Error Status and Gateway Event Notes options. The Error Status option is enabled
only when the gateway event has an error, and selecting this option opens the
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Gateway Event Error List window, which enables you to view the error information for
that gateway event.

Selecting the Gateway Event Notes option opens the Gateway Event Notes List
window, which enables you to view and maintain the notes for that gateway event.

Enhanced Process to Replace Installed Equipment

This enhancement extends the existing capability to replace installed equipment by
supporting more user scenarios, and improving the usability of the process. You can
now replace equipment having child equipment occupying one or more of its slots,
which was not previously supported.

The previous logic validated whether or not the replacement equipment fit into the
existing slots occupied by, and adjacent to, the current equipment.

The new logic includes the previous validation logic and, in addition, validates whether
the replacement equipment has enough available slots to support all of the child
equipment currently mounted within the existing equipment you have chosen to
replace.

Additionally, you can now also trigger the replacement process whenever the
equipment inventory is opened from the perspective of the Equipment Spec Usage
Report. While the functionality is the same, you now have multiple ways to initiate the
process.

The replacement process now includes support for Dedicated Plant. When replacing
equipment that belongs to one or more defined dedicated plants, the validation logic
ensures that the replacement equipment has been configured to support all of the
existing services currently assigned to the equipment being replaced, and does not
allow the replacement unless the validation is successful. When the equipment is
replaced, all equipment belonging to a dedicated plant is updated to the replacement
equipment within the dedicated plant definition, as well as all affected dedicated plant
DLR blocks.

Initiating the Equipment Replacement Process

To initiate the equipment replacement process:

1. To find the equipment to replace, do one of the following:

• To find the equipment to replace directly from Equipment Inventory:

a. On the navigation bar, select Inventory Management, and then select
Equipment Inventory.

The Equipment Inventory Search window is displayed.

b. Populate the Network Location field with the location of the equipment to
be replaced, select the Installed Status option, and click Search.

• To find the equipment to replace within the Equipment Spec Usage Report:

a. On the navigation bar, select Inventory Management Setup, and then
select Equipment Specifications.

The Equipment Spec Search window is displayed.
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b. Enter the required search criteria and click Search.

The Equipment Spec Search results window is displayed.

c. Select an equipment specification, and then either right-click and select
Usage Report..., or from the Options menu, select Usage Report....

d. Open the Equipment Inventory window by double-clicking the required
equipment specification.

2. Locate and right-click the equipment that you want to replace within the hierarchy
and do one of the following:

• Select the Replace... option to initiate the replacement with a new piece of
equipment based on your required equipment specification

• Select the Replace From Spare... option to initiate the replacement with an
existing piece of equipment from spare inventory

The Replace From Spare... option opens the Equipment Replacement - Find Spare
window, which enables you to search for the spare equipment to be used for the
replacement. You can choose the required equipment and close the window to
continue.

Both the right-click options allow you to enter and review the required attributes of the
replacement equipment in the Equipment - [New/Spare] Replacement maintenance
window. The replacement equipment inherits the Net Loc (Equipment), Network
Element, Status, and Work Order information from the current equipment, when
applicable. Additionally, all of the current equipment user data and common custom
attribute values are copied to the new replacement equipment, and you can choose to
either keep any values already defined for the spare replacement equipment, or to
replace these values with those from the current equipment.

After you have reviewed the replacement equipment's attributes, you automatically
launch the Equipment Replacement Assistant (ERA) by closing the Equipment - [New/
Spare] Replacement window, which guides you through the remainder of the
equipment replacement process. In addition to the previously supported mappings
between the port addresses of the current and replacement equipment, the ERA now
automatically generates slot mappings, which are used to position all of the child
equipment within the replacement equipment's hierarchy.

While the slot mappings default to 1:1 whenever possible, the application may move
the child equipment mounted within the current hierarchy to an available slot whenever
a 1:1 slot mapping is not possible. For example, if the current equipment has children
installed on slots seven and eight, the application may map them to slots five and six
when the replacement equipment has only six defined slots, as long as there is
enough capacity to mount all of the child equipment. While you cannot modify the
auto-generated slot mappings, you can view the results within the Review Proposed
Changes page, where you can review the proposed positioning for all child equipment.

The Select Condition Code(s) page displays all of the condition codes associated to
the ports and slots of the current equipment as before, when applicable, and the new
auto-generated slot mappings control where the selected slot condition codes are
transferred.

As before, you can review your proposed changes in the Before and After equipment
hierarchical views on the Review Proposed Changes page. However, a new top-and-
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bottom orientation is now provided by default, and you have the option to select the
previously supported side-by-side orientation, as well as a new layered option if you
need additional space to view the content.

After reviewing the proposed changes, you can trigger the completion of the
replacement process by clicking the Finish button in the ERA. You can subsequently
choose to process the resulting DLR Reconciliation in the foreground, send it to the
Background Processor, or cancel the entire equipment replacement process. After the
replacement process is completed, the Equipment Inventory view is refreshed to
display the newly installed equipment, which has inherited the resources of the
previously installed equipment.

Current Restriction of the Equipment Replacement Process

You cannot replace equipment having one or more defined virtual ports with
associated connections, IP addresses, cross-connects, or reservations. Virtual ports
are identified by the checked Virtual column on the Port Address tab within the
Equipment maintenance window.

Ability to Maintain Connection Links

This feature expands upon the existing Maintain Links capability, which enables you to
maintain the links defined for an order from within Connection Design, by now enabling
you to define and maintain links for the connection itself. A new Maintain Connection
Links link is now available under Actions in the Connection Summary view of the
Connection Design window. However, to more easily differentiate between these two
features, the previous Maintain Links feature is now accessed via the renamed
Maintain Order Links link.

Similar to the existing Maintain Order Links capability, the new Maintain Connection
Links feature is available for all connection and order types, but is visible only for
design issues associated to an order. All connection links added to a design issue are
only in scope for that issue, along with all other design issues for that connection
associated to the same order, and are copied to the new issue whenever a new design
issue is created. Therefore, it is possible to have unique connection links per design
issue for the same connection.

Maintain Links Renamed To Maintain Order Links Within
Connection Design

The existing Maintain Links link has been renamed to Maintain Order Links under
Actions in the Connection Summary view of the Connection Design window.

New Custom Extension for Generating and Maintaining Allocation
Parameters

A new Manage Allocation Parameters action type is now available within the custom
extension process point for Connection Design, which allows you to bypass the default
auto-generation of allocation parameters in favor of your own custom workflow. This
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feature enables you to augment the design capabilities of MSS with another
application, such as Oracle Communications Unified Inventory Management (UIM),
which provides a full logical resource life cycle.

Leveraging this new feature allows you to continue using MSS to design your services,
and to maintain a more robust logical resource inventory. While the values are still
displayed and stored within MSS, the resource pools may be defined and maintained
elsewhere.

While you are only required to configure one extension to enable this capability, it can
be triggered while performing the following activities:

• Selecting the new Generate Virtual Channels option from the Options menu
within the schematic design of a virtual connection. The Generate Virtual
Channels option is enabled only for ordered virtuals when an extension is defined
for the new Manage Allocation Parameters action type.

• Selecting the Remove Connection right-click option within the schematic design
of a virtual connection.

• Clicking the Redesign Connection link within the schematic design of a virtual
connection.

• Selecting the Group Disconnect option from the Options menu within the
Service Request Connections window while working the DLRD task of a
Disconnect order.

• Selecting the Assignment Cancel option from the Options menu within the
Service Request Connections window while working the DLRD task for a canceled
New order.

• Selecting the Change Cancel option from the Options menu within the Service
Request Connections window while working the DLRD task for a canceled Change
order.

• Selecting the Disconnect Cancel option from the Options menu within the
Service Request Connections window while working the DLRD task for a canceled
Disconnect order.

The new Generate Virtual Channels feature is designed to enable you to finish your
design work prior to generating any allocation parameters. After you have completed
your design, selecting this option collects every design segment and passes them to
the custom extension, which may then be coded to leverage the entire end-to-end path
of the connection in order to properly determine the allocation parameters for each hop
of the design.

Enhancements in Patch 27474657 (6.3.0.679)
The following sections describe the enhancements delivered in this patch.

Platform Upgrade

The application platform now supports upgraded software versions.

Certified Software Versions for the Application Server
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• Oracle Enterprise Linux Server 6.6 (or later) and 7.1 (or later)

• Red Hat Enterprise Linux Server 6.6 (or later) and 7.1 (or later)

• Oracle Solaris 11.2 or later

• Windows Server 2016

Certified Software Versions for the Workstation Client

• Windows 10 Professional

• Windows Server 2016

• Oracle Database 12cR2 Client (32-bit)

• Microsoft Edge 40 or later

See MSS Planning Guide for a full list of compatible software versions.

The following documents have been updated to reflect the Oracle Database 12cR2
and Oracle Fusion Middleware 12.2.1.3 support introduced in MSS 6.3.0.639 and MSS
6.3.0.643.3 respectively:

• MSS Planning Guide

• MSS Installation Guide

• MSS System Administrator's Guide

MSS Now Supports Both JDBC Connect String and Oracle Host,
Port, and SID Options for Running an MSS Database Instance as
a PDB

Previously, for running an MSS database instance as a pluggable database (PDB),
you were required to install the MSS application only by specifying the JDBC connect
string in the JDBC URL field on the Oracle Database tab in the MSS installer.

With this patch, for running an MSS database instance as a PDB, you can now install
MSS by specifying the Oracle Host, Port, and SID in the Oracle Server Name, Oracle
Port#, and the Oracle Service Name fields respectively or by specifying your own
free-form JDBC connect string in the JDBC URL field.

See MSS Installation Guide for more information.

Enhanced MSS EJB APIs

This release of MSS introduces new and improved features related to MSS EJB APIs.

Enhanced createWorkOrder EJB API to Create EWO With User Data

Prior to this enhancement, to add user data to an Engineering Work Order (EWO), you
were required to first create an EWO using the createWorkOrder EJB API, and then
add user data to the EWO using the updateWorkOrder API.
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In this release, the createWorkOrder EJB API has been enhanced to support the
addition of EWO user data as part of the EWO creation process.

Field Length Validations When Calling createWorkOrder EJB API

When calling the createWorkOrder EJB API, validations have been added for the
referenceId and responsiblePerson fields. The createWorkOrder EJB API API now
displays an error message in the following situations:

• When the length of the referenceId field exceeds 16 characters

• When the length of the responsiblePerson field exceeds 60 characters

EJB API Now Generates the documentNumber When Creating an EWO

Earlier, when creating an EWO through API, a non-sequence number was allowed as
primary key value (documentNumber), which caused data corruption.

In this release, when creating an EWO through API, the API generates the sequence
number for the document number.

See MSS EJB API Developer's Reference for more information about the MSS EJB
APIs.

MSS Web Service Updates

MSS now includes the Engineering Work Order Web Service, which enables an
external system to create and manage engineering work orders.

The Engineering Work Order Web Service includes the following operations:

• createWorkOrder

• updateWorkOrder

• getWorkOrder

• createWorkOrderNote

• updateWorkOrderNote

• processDDChangeSupplement

• associateEquipmentToWorkOrder

• associateConnectionToWorkOrder

In addition, the existing MSS Order Web Service now includes a new operation,
addTask, which enables an external system to add a task to an order that is not
completed and that has a provisioning plan assigned to it.

See MSS Web Services Developer's Guide for more information.

Simplified Process to Reinitiate Gateway Events from Work
Queue Manager
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This enhancement simplifies the process to reinitiate gateway events from the Work
Queue Manager window.

Previously, to reinitiate a gateway event associated with a task, you were required to
select the Reactivate right-click option first, and then select the Initiate right-click
option in the Gateway Events tab of the Work Queue Manager window.

In this enhancement, a new right-click option, Re-Initiate, has been added in the
Gateway Events tab of the Work Queue Manager window. The Re-Initiate right-click
option combines the functions of the Reactivate and Initiate right-click options;
therefore, selecting the Re-Initiate option reactivates and initiates the gateway event
associated with a task.

Reinitiating a Gateway Event

To reinitiate a gateway event:

1. On the navigation bar, select Home, and then click My Work Queue.

The Work Queue Manager window is displayed.

2. Select the task with the associated gateway event.

3. Click the Gateway Events tab.

4. Select the gateway event you want to reinitiate.

Ensure that the gateway event is in any status except Bypassed.

5. Right-click and select Re-Initiate, one of the following occurs:

• If you selected the Force Reopen check box for the gateway event in the
Gateway Events window, the Reactivate Gateway Events window is displayed.
Select the gateway event that you want to reinitiate and click OK, which
reinitiates the gateway event.

• If you did not select the Force Reopen check box for the gateway event in the
Gateway Events window, the gateway event is reinitiated directly.

MetaSolv Solution 6.3 Database Change Reference Introduced

The MetaSolv Solution 6.3 documentation set includes a new guide entitled MSS
Database Change Reference, which provides information about the database changes
that have been made in the MSS 6.3 patches.

Enhancements in Patch 27555375 (6.3.0.643.3)
The following sections describe the enhancements delivered in this patch.

Support for Oracle Database 12c Multitenant Architecture

MSS now supports the Oracle Database 12c multitenant architecture, which enables
you to run the MSS database instance as a pluggable database (PDB) within a
container database (CDB).
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When running an MSS database instance as a PDB, ensure that you install the MSS
application only by specifying the JDBC connect string. To do this, in the JDBC URL
field on the Oracle Database tab, enter your own free-form JDBC connect string.

Support for Oracle Fusion Middleware 12.2.1.3

MSS now supports Oracle Fusion Middleware 12.2.1.3 and continues to support
Oracle Fusion Middleware 12.2.1.2.

Enhancements in Patch 26557511 (6.3.0.639)
The following sections describe the enhancements delivered in this patch.

ASR 56 Support

MSS 6.3.0 patch 26557511 supports ASR 56.

Support for Oracle Database 12c R2

MSS now supports Oracle Database 12c Release 2 (12.2.0.1.0).

The following table lists the recommended initialization parameter settings for Oracle
Database 12c R2.

Parameter Value

_enable_secure_sub_role TRUE

_grant_secure_role TRUE

O7_DICTIONARY_ACCESSIBILITY TRUE

Increased the Length of the Expedited Work Interval Bus. Day
and Work Interval Bus. Day Fields

Prior to this enhancement, in the Expedited Work Interval Bus. Day and Work
Interval Bus. Day fields on the Task Assignment tab of the Provisioning Plan
window, you could specify only a two-digit number; that is, you could specify a number
only up to 99.

In this enhancement, the length of both the Expedited Work Interval Bus. Day and
Work Interval Bus. Day fields has been increased to accept a three-digit number so
that you can now specify any number up to 999.

Enhancements in Patch 26336562 (6.3.0.621)
The following sections describe the enhancements delivered in this patch.

Streamlined Process to Replace Installed Equipment
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This enhancement provides a new, simplified method for replacing an installed piece
of equipment. Two new right-click options have been added within Equipment
Inventory that enable you to replace the current equipment with a compatible part from
spare inventory, or to create a new instance from your preferred equipment
specification.

Validation logic that considers N/A rate codes and the Allow Lower Rates indicator
guarantees that the replacement equipment has enough compatible ports to support
the provisioned traffic, as well as confirming that it fits into the existing slots occupied
by, and adjacent to, the current equipment.

Initiating the New Equipment Replacement Process

To initiate the new equipment replacement process:

1. On the navigation bar, select Inventory Management, and then Equipment
Inventory.

2. Populate the Network Location field with the location of the equipment to be
replaced, select the Installed Status option, and click Search.

3. Locate and right-click the equipment that you want to replace within the hierarchy
and do one of the following:

• Select the Replace option to initiate the replacement with a new piece of
equipment based on your required equipment specification

• Select the Replace From Spare option to initiate the replacement with an
existing piece of equipment from spare inventory

The Replace From Spare option opens the Equipment Replacement - Find Spare
window, which enables you to search for the spare equipment to be used for the
replacement. You can choose the required equipment and close the window to
continue.

Both the right-click options allow you to enter and review the required attributes of the
replacement equipment in the Equipment - [New/Spare] Replacement maintenance
window. The replacement equipment inherits the Net Loc (Equipment), Network
Element, Status, and Work Order information from the current equipment, when
applicable. Additionally, all of the current equipment user data and common custom
attribute values are copied to the new replacement equipment, and you can choose to
either keep any values already defined for the spare replacement equipment, or to
replace these values with those from the current equipment.

After you have reviewed the replacement equipment's attributes, you automatically
launch the Equipment Replacement Assistant (ERA) by closing the Equipment - [New/
Spare] Replacement window, which guides you through the remainder of the
equipment replacement process. The ERA uses mappings between the port
addresses of the current and replacement equipment to control the transition of
resources to the replacement equipment. For example, if the first port on the current
equipment is mapped to the third port on the replacement equipment, then the
connections, cross-connects, IP addresses, condition codes, and reservation currently
associated to port one, are moved to the third port of the replacement equipment.

The ERA autogenerates default mappings based on the compatibility of the
replacement ports with the current ports. You can choose to keep or modify these
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mappings as necessary, but you can make modifications only to the top-level physical
ports. The enabled port hierarchies of each physical port are mapped 1:1 with the
enabled port hierarchies of the mapped physical port when they have compatible rate
codes, and are not editable. When you manually override the default mappings, the
validation logic ensures that each mapped port is compatible, supports any existing
traffic, and that all current ports with provisioned traffic have been mapped to a
replacement port.

The Select Condition Code(s) page displays all of the condition codes associated to
the ports and slots of the current equipment, and allows you to choose which codes to
copy to the replacement equipment. All values are selected by default; therefore, you
must deselect the condition codes that you do not want to retain after the equipment is
replaced. This page is not displayed when there are no condition codes associated to
the current equipment.

Before finishing the ERA, review your proposed changes in the Before and After
equipment hierarchical views on the Review Proposed Changes page, where you can
validate that all of the connections, cross-connects, IP addresses, condition codes,
and reservations associated to the current equipment have been moved to the proper
replacement ports. If you want to make any changes, you can go back to the previous
page and modify the mappings to achieve the required results. You can also indicate
to either delete or uninstall the current equipment, as well as choose to clear the
equipment name if you choose to uninstall the equipment.

After reviewing the proposed changes, you can trigger the completion of the
replacement process by clicking the Finish button in the ERA. You can subsequently
choose to process the resulting DLR Reconciliation in the foreground, send it to the
Background Processor, or cancel the entire equipment replacement process. After the
replacement process is completed, the Equipment Inventory view is refreshed to
display the newly installed equipment, which has inherited the resources of the
previously installed equipment.

Limitations:

The equipment replacement process has the following limitations:

• You can replace only the lowest-level piece of equipment within the hierarchy.

• You cannot replace equipment having one or more defined virtual ports with
associated connections, IP addresses, cross-connects, or reservations. Virtual
ports are identified by the Virtual column on the Port Address tab of the
Equipment window.

Improved Usability of Cable and Cable Pair Search Windows

This enhancement improves the usability of the Cable and Cable Pair Search windows
by enabling you to easily identify pairs/fibers with condition codes.

Similar to the Connection Hierarchy and Equipment Inventory views, either
[BLOCKED] or [INFORMATION] is displayed for each pair/fiber with one or more
condition codes, depending on the warning type.

A new column, Warning Type has been added in the Cable Pair Search results, which
displays the type of condition codes to help you select a pair/fiber to assign to.
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Existing Cross-Connects Can Now Be Deleted With the
Equipment

Prior to this enhancement, you received an error within Equipment Inventory when
attempting to delete or uninstall equipment having defined cross-connects, which
prevented you from performing this action. To successfully delete or uninstall the
equipment, you first had to navigate to the existing cross-connects and manually
remove them.

This enhancement streamlines the deletion and uninstallation tasks by providing an
option to remove any existing cross-connects as part of the deletion and un-installation
processes.

Instead of displaying an error that prevents you from proceeding with the deletion
process, the application now displays a message that informs you that one or more
defined cross-connects exist for the equipment. You can choose to either continue
with the deletion/uninstallation of the equipment (which will also remove the cross-
connects) or cancel the process altogether.

Associated Network Area Now Displayed in Telephone Number
Search Results and Maintenance Windows

This enhancement improves the usability of the Telephone Number search and
maintenance windows by displaying the associated network area in each window.

A new Network Area column is now displayed after the existing Network Location
column in the Telephone Number search results and in the Telephone Number
Properties section of the maintenance window.

Maintain Order Links in Connection Design

This enhancement enables you to maintain the links defined for an order in the
Connection Design window. For ordered connections, a new Maintain Links link has
been added under Actions in the Connection Summary view of the Connection Design
window. Clicking this link opens the Related Links page for the order associated to the
active design issue, which lets you edit or remove an existing link, or add a new one.

The Maintain Links link has been added for all connections and order types; however,
this link is visible only for the design issues that are associated to an order.

ASR Billing and Additional Circuit Details Added to Work Queue
Manager

This enhancement adds two new ASR billing-related tabs, Billing and EVC Billing, in
the Work Queue Manager window. New columns are also available on the existing
Circuits tab. The new tabs are enabled only for ASR EVC orders, and they display the
information from the order. The Circuits tab is always enabled, but the new fields are
populated only for ASR orders.

The following fields are available on the newly added Billing tab:
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• SPEC (Admin)

• PNUM (Billing)

• VTA (Billing)

• ICSC (MEC)

• OECVTA

• OECPNUM

The following fields are available on the newly added EVC Billing tab:

• UREF

• UACT

• LREF

• LOSACT

• LOS

• SPEC

• BDW

The following fields are now available on the Circuits tab:

• Jurisdiction code

• PLU

• PIU

Open Connection Design Directly from Cable Inventory

This enhancement enables you to open the Connection Design window directly from
within Cable inventory.

In this enhancement, a new right-click option, Connection Design, has been added in
the following windows:

• Cable inventory

• Cable Pair Hierarchy within a Reservation

• Cable hierarchy within Dedicated Plant

From the windows listed previously, you can now open the Connection Design window
by right-clicking and selecting Open, and then selecting Connection Design.

The new Connection Design right-click option is available only for pairs/fibers that
have an assigned connection.

Enhancements in Patch 25541947 (6.3.0.555)
The following sections describe the enhancements delivered in this patch.

ASR 55 Support
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MSS 6.3.0 patch 25541947 supports ASR 55.

MSS Database Changes

The following database change has been made in this release:

• Release: 6.3.0.555

• Prodfixsql file: 25940130.sql

• Change: Modify columns

• SQL: alter table asap.equipment_spec modify (equipment_acronym varchar2(25))

Increased the Length of the Acronym Field for Equipment

In this enhancement, the length of the Acronym field has been increased from 10 to
25 characters at the following MSS GUI locations:

• Equipment Spec Search window

• Equipment Spec window

• Equipment Cross-Connect Report

Ability to Add Links on Orders From Work Queue Manager

In this enhancement, a new option, Add a Link, has been added to the Options menu
of the Work Queue Manager window. You can also access the Add a Link option by
right-clicking in the Work Queue Manager window.

Selecting an order and then selecting the Add a Link option displays the Related
Links window, which enables you to add links to useful resources (web pages,
spreadsheets, documents, and so on) on the selected order.

Adding New Links on Orders

To add new links on orders:

1. On the navigation bar, click Home, and then click My Work Queue.

The Work Queue Manager window is displayed.

2. Select an order and do one of the following:

• Right-click and select Add a Link.

• From the Options menu, select Add a Link.

The Related Links window is displayed.

3. Under the New Link section, do the following:

a. In the URL field, enter the URL for the web page or click Browse to navigate
to the resource to which you want to add a link.

b. In the Name field, enter a name for the resource.
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c. Click Test Link to verify whether the link is working or not.

d. Click Add.

The newly added link is displayed under the Link section.

Editing Existing Links on Orders

To edit existing links on orders:

1. On the navigation bar, click Home, and then click My Work Queue.

The Work Queue Manager window is displayed.

2. Select an order and do one of the following:

• Right-click and select Add a Link.

• From the Options menu, select Add a Link.

The Related Links window is displayed.

3. Under the Link section, click Edit beside the link that you want to edit.

4. Under the Edit Link section, do the following:

a. In the URL field, update the URL for the web page or click Browse to navigate
to the resource to which you want to add a link.

b. In the Name field, enter a name for the resource.

c. Click Test Link to verify whether the link is working or not.

d. Click Save.

Removing Existing Links on Orders

To remove existing links on orders:

1. On the navigation bar, click Home, and then click My Work Queue.

The Work Queue Manager window is displayed.

2. Select an order and do one of the following:

• Right-click and select Add a Link.

• From the Options menu, select Add a Link.

The Related Links window is displayed.

3. Under the Link section, select the check box beside the link that you want to
remove.

4. Click Remove.

ISI-DLR Information Now Displayed for Virtual Connections

In this enhancement, a new ISI-DLR tab has been added in the Additional Details view
of the Connection Design window for virtual connections. The ISI-DLR tab displays the
following information:
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• Interexchange Carrier

• IC Circuit Reference

• PON

• Due Date

• ACTL

• APOT

• NCI

• NC

• SEC NCI

In addition, the ISI-DLR section has been added in the GLR report for virtual
connections. The ISI-DLR section displays the following information:

• IC CIRCUIT REFERENCE

• ACTL

• APOT

• NC

• NCI

• SECNCI

You view the GLR report by selecting GLR from the Outputs menu in the Connection
Design window for virtual connections.

Additional Fields in Service Request Search Window When
Searching for ASRs

This enhancement improves the process of searching for ASRs in the Service Request
Search window by providing additional fields for use in your search criteria.

In the Service Request Search window, the following new lists and fields have been
added, which are displayed after you select ASR and Service Request from the
Search By lists:

• PROJECT: This field enables you to search for ASRs by specifying the project
number.

• CNO: This field enables you to search for ASR orders by specifying the case
number of the ASR order.

• SPEC: This field enables you to search for ASRs by specifying the service and
product enhancement code.

• PNUM: This field enables you to search for ASRs by specifying the promotion
number.

• OECPNUM: This field enables you to search for ASRs by specifying the other
exchange company promotion number.
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• NC: These lists enable you to search for ASRs by selecting the network channel
code.

Operating Company Column Added in Network Location Search
Results Window

In this enhancement, a new Operating Company column has been added in the
Network Location Search Results window. The Operating Company column displays
the name of the operating company that owns the CLLI code associated with the
network location.

Assigning Contiguous Telephone Numbers

You can now assign contiguous telephone numbers that fall within the specified line
range. In this enhancement, a new Contiguous check box has been added in the
Search tab of the Telephone Numbers window. To search for contiguous telephone
numbers, select the Contiguous check box, select a value from the NPA list, and then
click Search.

For example, suppose that in a telephone number block containing 50 telephone
numbers in the line range of 0000 through 0050, the line 0015 has already been
assigned and is in InService status. Within this 50-number line range, if you search for
20 contiguous telephone numbers for assignment, the application ignores the lines
from 0000 to 0015 (because 0015 is already assigned), and considers the lines that
fall within the range from 0016. In this situation, the application retrieves 20 contiguous
telephone numbers in the line range of 0016 through 0035.

Additionally, you can now select multiple statuses of telephone numbers in the Status
field on the Search tab of the Telephone Number window. To select multiple
telephone number statuses, click the down arrow beside the Status field, select the
statuses that you want to search for, and then click the down arrow again, which
displays the statuses that you selected in the Status field. After you click Search, the
application retrieves the telephone numbers having the various statuses based on
your search criteria.

Newly Installed Equipment That Are Removed from Engineering
Work Orders Are Now Permanently Deleted from the Application

Previously, when you removed newly installed equipment from an Engineering Work
Order (EWO), the removed equipment was moved to the spare inventory at that
location rather than being deleted.

In this enhancement, when you remove an equipment from an EWO, the following
occurs:

• If the equipment was newly created and then installed, it is removed from the
EWO and permanently deleted from the application.

• If the equipment was installed from spares storage, the equipment is removed
from the EWO and moved back to spare storage.
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Updated Confirmation Message When Removing Equipment from
an EWO

The existing confirmation message that appears when removing equipment from an
EWO has been updated as follows:

This action will permanently delete newly installed equipment and move equipment 
that was installed from spare back to spare status. Would you like to continue?

After you click Yes on this confirmation message, the following occurs:

• If the equipment was newly created and then installed, it is removed from the
EWO and permanently deleted from the application.

• If the equipment was installed from spares storage, the equipment is removed
from the EWO and moved back to spare storage.

Removing Equipment Having Child Equipment on a Different
EWO

If the equipment you are removing has child equipment on a different EWO, the
application now displays the following confirmation message:

The following equipments are open in Engineering Work Orders
EQUIP-1234-CARD    EWO1234
Continue with the delete?

Clicking Yes on this confirmation message deletes both the parent and child
equipment from their respective EWOs.

Removing Equipment Having Child Equipment on the Same EWO

If the equipment you are removing has unselected child equipment on the same EWO,
the application now displays the following confirmation message:

The equipment EQUIP-1234 has the below child(ren) unselected in the order. Please 
select the child(ren) also for removal.
EQUIP-ABC,1 NEW CARD

Click OK on this confirmation message, select the child equipment, and then click
Remove.

Updated Confirmation Message When Removing Equipment from
Equipment Inventory

In addition, the existing confirmation message that appears when removing equipment
from the Equipment Inventory window has been updated to display additional
information if the equipment you are removing is open on an EWO. The confirmation
message now displays information such as vendor name, vendor part number,
equipment name, and order number:
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This delete affects the following equipment tied to an Engineering Work Order:
EXAMPLE CORP,1 NEW CARD Order 1234567
Continue with the delete?

Clicking Yes on this confirmation message deletes the equipment from both the
equipment inventory and the EWO.

Ability to Search for Connections by Project ID

In this enhancement, in the Connection Design Search and Connection Hierarchy
Search windows, a new Project field has been added that enables you to search for
connections by specifying the project ID as a search criterion.

The newly added Project field is displayed when you right-click and select Service
Request in the Connection Design Search or Connection Hierarchy Search windows.

Network Location Code of Equipment Now Displayed in
Equipment Description

In this enhancement, in the Equipment Inventory window, the equipment description
now displays both the network element (associated with the equipment) and the
network location code (CLLI code) of the equipment, provided that you have specified
both the values; otherwise, only the value that you have specified is displayed. You
specify the network element in the Network Element field and the network location
code in the Net Loc (Equipment) field in the Equipment tab of the Equipment
window.

Similarly, the Equipment Inventory for Connection Design window has been enhanced
to display both the network element and network location code in the equipment
description. The Equipment Inventory for Connection Design window is displayed
when you open the Equipment Inventory window from within Connection Design.

All information (except network element and network location code) displayed in the
equipment description depends on the setting of the Equipment Description
preference under Preferences - Equipment - Equipment Inventory. For example,
suppose that you configure the Equipment Description preference as follows:

• Position 1 = manufacturer (for example, EXAMPLE CORP)

• Position 2 = part number (for example, PART567#1)

• Position 3 = acronym (for example, ABCEQUIP)

If you specified only the network element (for example, DLLSTX01#4) for the
equipment, the equipment description displays the following:

EXAMPLE CORP PART567#1 ABCEQUIP (DLLSTX01#4) 

If you specified only the network location code (for example, DLLSTX01B01) for the
equipment, the equipment description displays the following:

EXAMPLE CORP PART567#1 ABCEQUIP (DLLSTX01B01)
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If you specified both the network element and the network location code (for example,
DLLSTX01#4 and DLLSTX01B01) for the equipment, the equipment description
displays the following:

EXAMPLE CORP PART567#1 ABCEQUIP (DLLSTX01#4 / DLLSTX01B01)

Increased the Length of a Few Fields in the Equipment Spec
Window

In this enhancement, in the Equipment Spec tab of the Equipment Spec window, the
length of the following fields has been increased to display all of the data without
truncating it:

• Manufacturer

• Part Number

• Mounting Type

• Description

• Notes

• Material Code

Usage Column Added in Equipment Spec Search Results
Window

In this enhancement, a new Usage column has been added in the Equipment Spec
Search Results window. The Usage column displays the number of installed instances
of each equipment specification.

You can open the Equipment Spec Search Results window from the following MSS
GUI locations:

• Inventory Management Setup - Equipment Specifications

• Product Specifications Window - Equipment Spec Tab

New Preference to Choose Whether Child Virtuals Should Inherit
the IP Address of the Parent Physical Connection

In MSS, if a parent physical connection already has an IP address assigned to it, you
cannot assign an IP address to its child virtual connection because the child virtual
connection inherits the IP address of the parent physical connection; consequently, the
Assign IP Address right-click option is grayed out in the Schematic Design view of
the Connection Design window for the child virtual, which prevents you from assigning
an IP address to the child virtual.

In this enhancement, a new preference, Inherit Parent Physical Connection IP
Address for Child Virtual, has been added that enables you to choose whether you
want the child virtual to inherit the parent physical connection's IP address.

Treeview Location: Preferences - Inventory Management - Connection Design
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The Inherit Parent Physical Connection IP Address for Child Virtual preference
has the following options:

• Y (the default): The child virtual inherits the IP address of the parent physical
connection.

• N: The child virtual does not inherit the IP address of the parent physical
connection. You can assign an IP address to the child virtual connection using the
Assign IP Address right-click option in the Schematic Design view of the
Connection Design window.

The IP address assignment rules are applicable when assigning an IP address to the
child virtual. For example, when assigning an IP address to the child virtual's
originating element, the application checks whether the terminating element has an IP
address assigned; if yes, the Number Inventory Search window retrieves IP addresses
from the same subnet as that of the terminating element's IP address.

Enhancements in Patch 25385094 (6.3.0.516)
The following sections describe the enhancements delivered in this patch.

Integration with Oracle Communications Unified Inventory
Management to Support Multipoint Carrier Ethernet Services

This enhancement includes a reference implementation that enables you to integrate
Oracle Communications MetaSolv Solution (MSS) with Oracle Communications
Unified Inventory Management (UIM) to enhance the existing capabilities of MSS to
order and design multipoint services, specifically Carrier Ethernet services.

In this reference implementation, UIM enhances the existing capabilities of MSS by
providing the following features:

• Support for Carrier Ethernet services, such as E-LAN, E-Tree, E-Access, and E-
Line

• A data model that conforms to Metro Ethernet Forum (MEF) Carrier Ethernet 2.0
standards

• VLAN ID lifecycle management

• Logical device management

• Support for designing virtual networks (service networks and multipoint EVCs)

• Design-and-assign logic for service orchestration

• Federation framework to integrate external systems

The reference implementation uses a cooperative design approach that facilitates
rapid creation of the Carrier Ethernet service. The provisioning flow of the service
order is as follows:

• MSS captures the order information for the Carrier Ethernet (multipoint EVC)
service and creates a provisioning plan.
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• MSS shares the order information and service fulfillment data with UIM using web
services submitted via MSS custom extensions.

• UIM creates a service and designs the service configuration with the resource
assignments and displays this information within MSS. You can modify the service
design by navigating directly to UIM from within the MSS application.

In this reference implementation, the physical connectivity, equipment, port
assignments, and resource network continue to reside within the MSS inventory.
Additional entities for service, service and packet virtual networks, service connectivity,
logical devices, and VLAN IDs are managed within UIM, and are used in the service
design process. The network entities, such as end user locations (service locations)
and network locations are shared between UIM and MSS.

The reference implementation leverages the Product Service Request (PSR) and
Work Management capabilities of MSS. Within the MSS application, you can manually
enter your requirements for the Carrier Ethernet service via the PSR order or through
the PSR API.

A new UIMDSGN task has been added that automates the process of submitting the
Carrier Ethernet service requirements (via the PSR order) to UIM. The UIMDSGN task
sends the PSR order information to UIM using the UIM Service Order Fulfillment Web
Service (SFWS), which is formatted and submitted via a new custom extension
UIMServiceDesignAdapter added within the MSS custom extension framework. You
can also configure the UIMDSGN task as a system task.

A new UIMVIEW task has been added that enables you to navigate directly from the
MSS work queue to the EVC Service Summary page in UIM. Adding the UIMVIEW
task is optional. If you choose to add the UIMVIEW task, you must add it after the
UIMDSGN task in the provisioning plan.

After you complete the UIMDSGN task, MSS creates the service designs for the EVC
service and EVC sites within the PSR order, which is controlled and integrated with
UIM using a UIM Business Interaction. The Order Information - Links tab contains
links that enable you to navigate directly to the EVC service and EVC site designs
within UIM, so that you can modify the designs if necessary.

For detailed instructions about installing the required software, setting up MSS and
UIM, and integrating MSS with UIM for the reference implementation, see Knowledge
Article 2243408.1 on the My Oracle Support website:

https://support.oracle.com

MSS EJB API Developer's Guide Introduced

The MetaSolv Solution 6.3 documentation set includes a new guide entitled MSS EJB
API Developer's Guide. This guide describes the various MSS Enterprise JavaBeans
(EJB) APIs that are available, explains how you can use the MSS EJB APIs to perform
specific tasks, and provides information about the required input parameters for each
MSS EJB API, including sample data values for the input parameters. Specifically, the
MSS EJB API Developer's Guide provides information about the following MSS EJB
APIs:

• Connection EJB APIs: You use the connection EJB APIs to create, update, and
auto-build connections, and to assign and unassign ports for connections.
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• Engineering Work Order (EWO) EJB APIs: You use the EWO EJB APIs to
create and update work orders (including work order notes), to associate
connections and equipment to work orders, and to process due date supplements.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.
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